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Overview 

What Happened to my Data? 

When partition (volume, drive, etc...) is deleted from a hard drive, two systems are notified:  

1. The partition record in the Partition Table (which is a part of MBR) is removed.  
2. Space where partition was located is labeled as 'unoccupied'. The data itself is not removed. 

In the event of an accidental partition deletion we strongly recommend that you perform the recovery 

operation as soon as possible. If any new partition is created instead on the same space and some 

information is written there, there is a chance that the writing process may allocate some data in this 
'unoccupied space' thus damaging you data located on the partition deleted previously.  

Welcome to Active@ Partition Recovery 

Active@ Partition Recovery is a powerful software utility, designed to restore accidentally deleted partitions 

and partitions being damaged by virus or any other cause.  Active@ Partition Recovery can be installed on 
and run from USB disk or bootable CD/DVD, so that the risk of overwriting your data is minimized. 

Active@ Partition Recovery will help you to restore partitions residing on hard drives formatted in any of the 
following file systems: 

• Microsoft FAT/exFAT, NTFS & ReFS  

• Apple HFS+ / ApFS 
• Linux Ext2 / Ext3 / Ext4, XFS, JFS & BtrFS 
• Unix UFS, JFS, XFS & ZFS 
• CD/DVD/Blu-ray, UDF & ISO9660 

It works under all Windows family operating systems:  

• Windows 11, Windows 10, Windows 8, Windows 7 

• Windows Server 2000, 2003, 2008, 2008 R2, 2012, 2016, 2019, 2022 
• Windows XP, Vista 
• Windows PE (embedded Windows environment loaded from CD/DVD/BD or USB disk 

Active@ Partition Recovery supports: 

• IDE, SATA, eSATA, SAS, SSD, NVMe, SCSI hard drives, USB Drives and Memory Cards 

• Large-sized drives (more than 2 TB)  
• Detection and recovery of deleted or damaged partitions  
• Saving scan results to the storage and opening them later on  
• Deleted partitions filtering 
• Correcting BOOT.INI if needed to keep the system bootable 
• Fixing damaged MBR and Deleting invalid partitions 
• Automatic and Manual correction of Volume Boot Sectors 
• Disk Image creation for further data recovery purposes 
• Integration with a Disk Viewer/Editor - to be able to inspect raw disk/partition/file data 

New in version 25 

 Latest recovery Kernel 15.01.17 includes many improvements and bug fixes 
 Added eBooks signatures recovery: MOBI, AZW, AZ3, AZ4, PRC, EPUB  
 Improved recovery of properties for PDF, MP3 and other signatures 
 The latest Linux Boot Disk based on openSUSE Leap 15.6 
 Active@ Boot Disk upgraded to WinPE based on Windows 11 24H2 code base 
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New in version 24 

 Latest recovery Kernel 14.01.17 many improvements and bug fixes 
 Improved recovery for volumes with cluster size > 64Kb 
 Added Virtual Device mode that allows to define  custom sector size and starting data offset within a sector 
 Improved Boot Disk – added Display Scaling and Network Drive Mapping 
 Active@ Boot Disk upgraded to WinPE based on Windows Server 23H2 code base 

New in version 23 

 Improved recovery of NTFS volumes formatted with large cluster size 
 Latest recovery Kernel including many improvements and bug fixes 
 Ultimate package: improved Bootable Disk Creator – stores custom configuration for WIM PXE boot 
 Ultimate package: Active@ Boot Disk switched to the latest WinPE v.10 based on Windows 11 v22H2 code base 

New in version 22 

 Performance enhancements and bug fixes 
 Ultimate package: improved Bootable Disk Creator 
 Ultimate package: Active@ Boot Disk switched to the latest WinPE v.10 based on Windows 11 v21H2 code base 
 Added new predefined file signatures recognition: 

 Apple iWork Pages (PAGES) 
 Apple iWork Numbers (NUMBERS) 
 Apple iWork Keynotes (KEY) 

New in version 21 

 Added applying Boot Sector Template (all major file systems supported) to any disk’s sector 
 Latest Recovery Kernel includes many improvements and bug fixes 
 Ultimate version: Active@ Boot Disk upgraded to WinPE based on Windows 10 build 2004 
 Ultimate version: Active@ LiveCD upgraded to openSUSE 15.2: Linux Kernel 5.3, KDE 5.18 

New in version 20 

 Added recovery of Apple ApFS file system 
 Re-implemented recovery of Microsoft ReFS file system 
 Latest Recovery Kernel including many improvements and bug fixes 
 Added new pre-defined file signatures:  

 Ancestral Quest Database File (*.AQ) 
 LibreOffice Documents  
 WPS Office Documents 

New in version 19 

 Improved Welcome Dialog and Registration 
 Improved recovery of disks having 4KB (4096 bytes) sector size 
 Latest Recovery Kernel including many improvements and bug fixes 
 Improved software stability working with failing disks 
 Added pre-defined file signatures:  

 Finale Notation File (MUSX) 
 Canon Raw Image File (CR3) 

 Ultimate package: Active@ Boot Disk upgraded to WinPE based on the latest Windows 10 build 1903 
 Ultimate package: Active@ Boot Disk now fully supports SATA & PCI-E NVMe M.2 disks 

New in version 18 

 Implemented more pre-defined algorithms for file signatures recognition:  
 Microsoft Office Documents (ONE, PUB) 
 MySQL files (IBD,FRM,MYI) 
 Oracle VirtualBox (VDI) 
 Betacase Client Info (BCB) 

 Ultimate: New Easy Mode for File Recovery – simplifies search for lost files and data recovery on live volumes 
 Ultimate package: The latest Active@ Boot Disk & Active@ LiveCD with Boot Disk Creator improvements 
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Using QuickScan to detect partitions just 
deleted 

QuickScan searches for partitions being just deleted. Before you can recover partition, you must scan 
unallocated space to detect the drive being deleted.  

 There are two methods for scanning: QuickScan and SuperScan.  

  

 QuickScan is a fast and basic scan. Partitions that have just been deleted most likely will be detected 
using this method (if no other partition has been created in unallocated space).  

 SuperScan is a much slower and thorough scan. It processes the whole hard drive surface 
detecting all possible deleted data. After running QuickScan, if you haven't found proper partition, try 

SuperScan.  

To run QuickScan, open Active@ Partition Recovery and do one of the following: 

 Just click QuickScan toolbar button. It will scan ALL unallocated areas on ALL hard disk drives (and 

removable devices).  
 In the Local System Devices list, select the Unallocated Space under the particular Hard Disk 

Drive or USB Disk and click QuickScan toolbar button or right-click the Unallocated Space and 

select QuickScan from the context menu.   

Disk scanning starts. To stop the scanning process for any reason, click Cancel button. 

You can tell the state of your partitions by the color of the icons: 

 Grey icon shows an existing partition 

 Grey icon with Green box shows a deleted partition that can be recovered 

 Grey icon with Red box shows a deleted partition that can be recovered, however this partition might has 
been formatted before deletion or has some other damage. 

   

After you complete the drive scan, to locate your deleted partitions, just look under Unallocated Space 

nodes. If new partitions having blue and lime icons  appear there - inspect them (click on icon) and verify 
their content browsing the files and folders.  
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You can inspect the content of the file by selecting the file and clicking Preview toolbar button, or executing 

Preview command from the context menu, or by pressing Alt+P key combination.  

If you satisfied with results, proceed with a partition recovery (click Recover toolbar button). 

 

Using SuperScan to analyze deleted and 
severely damaged volumes 

Use SuperScan when trying to recover a partition or logical drive that you know has been deleted or 
damaged and cannot be detected by QuickScan.  

Another reason to use SuperScan is when the volume has been quick-formatted, or disk's surface has been 
heavily overwritten by other data, so you are not able to find your deleted data using QuickScan.  

SuperScan processes the whole surface of the physical device searching for all possible logical drives and 

partitions, whether they are live, damaged or deleted. If a partition cannot be found, SuperScan keeps 
searching.  SuperScan reads each disk sector and looks for not only the boot sector, but also tries to 

reconstruct the drive structure, based on residual clues to the drive's system structures that remain on the 
disk surface. This is a very slow process and it usually gives much more results than QuickScan.  

To run SuperScan: 

1. In the Local System Devices list, select a physical device, or a volume that contains your data. It 
may be a Fixed Disk, USB external or Removable Disk, Memory Card, and even Floppy Disk.  

2. To open the SuperScan Options dialog box, do one of the following:  

o In the toolbar, click SuperScan   
o Right-click the physical device node and choose SuperScan from the context menu  

o Execute SuperScan command from Tools menu  
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3. Fields From and Size contain currently selected object's geometry in sectors. You can switch 

geometry display to other units (Bytes, MB and GB) using drop down combo box. If you click Scan 
now - this area will be scanned by default  

4. To select disk's area manually, type the starting sector number in the From field and the number of 

sectors in the Size field. If you need several areas to be scanned, define area parameters and click 
Add button, then type other area parameters and click Add again  

5. In the Analyze and detect deleted or damaged partitions area, select the check boxes next to 
the partition types that you want to look for. Clear the check boxes next to the partitions that you do 

not want to look for. If you select all partition types, the scanning takes a longer time, however you 
may find more recoverable partitions  

6. Click Scan or press Enter to start SuperScan process  

7. The statistics and progress bar appear underneath the scanning area. To stop the SuperScan at any 
time, click Pause red button at bottom, or choose Pause SuperScan from the context menu. If 

SuperScan has been paused, you may resume it by clicking Resume button at bottom or by 
choosing Resume SuperScan from the context menu. If you have saved paused SuperScan results, 

its state being saved as well, so you can resume SuperScan later on, after loading SuperScan results 

- even after re-boot, or on another machine having the same HDD/USB disk attached  

  
8. For each SuperScan process a new virtual folder named SuperScan [YYYY-MM-DD HH:MM:SS] 

has been added to the Local System Devices list. The contents of this folder displayed in the tree 

(left panel) as well as in the Volumes tab (right panel). You may treat SuperScan virtual folder and 
its contents the same way that you treat other device nodes in the list.  
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Inspecting SuperScan results  

SuperScan can be a long process. You can check the estimated run time displayed on the status panel at 

bottom of the Scanning Area. You can wait until SuperScan finishes, or you can inspect and manage found 
partitions (volumes) "on-the-fly":  

 Click the volume in the tree (left panel) to highlight the volume position in the Scanning Area (right 

panel)  
 Right-click the volume and choose Properties from the context menu - to check volume integrity 

and attributes being detected  

 Double-click the volume, or choose QuickScan from the context menu - to scan the volume, browse 

its folders, view files and so on  
 You can preview files from the found volume while SuperScan is still in progress  

You can inspect the content of the file by selecting the file and clicking Preview toolbar button, or executing 

Preview command from the context menu, or by pressing Alt+P key combination.  

 Important 

After you complete a SuperScan, you may find hundreds of partitions. Volumes having different locations and 

size, may have been created and then deleted at different times on the device being scanned. If you have 
virtual VMware workstation profiles (from VMware, Inc.) or VirtualPC profiles (from Microsoft Corp.), these 

files also contain partition information. Moreover, if remaining system areas of damaged disk structures not 
enough to define all necessary partition parameters, SuperScan uses complex algorithms to project the most 

probable parameters and instead of one partition could create 10-20 partitions having different sizes, offsets, 

cluster size and so on. This does not mean that SuperScan creates a lot of garbage. This means that among 
these projected partitions most likely will be the one you've lost, and most likely you'll be able to find and 

recover your data. So, if you cannot find your data on the volumes having Excellent or Good recovery status, 
it is still recommended that you wait until SuperScan finishes and then inspect all found volumes once again.  

Filtering SuperScan results  

To reduce the amount of work, you may use a filter so that you are working with a smaller set of data. After 
the SuperScan, all detected volumes are displayed. When you change the settings in the filter dialog box, you 

can display only selected types of volumes. 

To filter SuperScan results: 

1. After running SuperScan, select the virtual folder with the name SuperScan [date time stamp]  
2. Right-click the node. From the context menu choose Filter... The Filter Found Volumes dialog box 

appears  
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3. To select the types of file systems to display, in the File Systems area, clear the check box beside 
the types that you do not want to display. Only the selected types of file systems data will be 
displayed  

4. To display only those partitions within a specified size limit, in the Volume Size area, indicate the 

minimum and maximum sized partitions in Megabytes (MB). Only those partitions within the specified 
range will be displayed  

5. To use basic filtering parameters, click Basic Filtering. To select displayed partitions based on 
partition status, in the Basic Filtering [Volume Status] area, clear the check box next to each 

partition status number that you do not want to display. Only the selected status ratings will be 
displayed  

6. To use advanced filtering parameters, click Advanced Filtering and use the bottom section:  

o To restrict displayed results for found boot sector's attributes (file system-independent), in 
the Basic Attributes area, select the check box beside all the types of data that you want 

to display  
o To restrict displayed results for NTFS-specific parameters, in the Specific to NTFS 

attributes area, select the check box beside all the types of data that you want to display  

o To restrict displayed results for FAT-specific parameters, in the Specific to FAT attributes 
area, select the check box beside all the types of data that you want to display  

7. Click Filter to set up a filter for all volumes found by SuperScan  

Storing and loading SuperScan results 

Depending on the size of the drive that you are scanning, it can take a long time to scan partitions. On large 
or damaged drives, it can take hours. If you have to exit Active@ Partition Recovery for any reason, it would 

take a long time to scan the partition again. So that you don't lose the information that you have scanned, 

you may save the SuperScan results to a file. When you open Active@ Partition Recovery, opening the saved 
results file takes much less time. 

If you decide to stop the SuperScan process, it is easy to continue scanning from the point that you stopped. 
After SuperScan has stopped, you may save the SuperScan virtual folder results, exit and re-start the 

application, open SuperScan results and resume SuperScan from the last point. To continue scanning, select 
the SuperScan virtual folder and click Resume button on the right of the progress bar.  
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To save SuperScan results 

1. In the Local System Devices list, select the SuperScan virtual folder and do one of the following:  
o Right-click the device node. From the context menu click Save Scan Results...  

o From the File menu, choose Save Scan Results...  

2. In the Save Scan Results dialog box, type a path or browse to a folder where the scan results file 
is to be stored  

3. Click Save  

To open SuperScan results 

1. From the File menu click Open Scan Results...  
2. In the Open Scan Results dialog box, browse to the file where you saved the scan results file  
3. Click Open  

4. In the Matched Devices dialog box confirm the device name (HDD/USB name) to apply SuperScan 

results for.  

 Note: Several devices might have the same name, for example, similar disks usually used in RAID 
arrays. In this case the order they appear in Matched Devices dialog matches the order devices 

appear in Local System Devices list. You may inspect your disks in Local System Devices list to know 

for sure which device to choose.  

 

 Important 

SuperScan results can be saved automatically. You can configure this option and storage path in General 

tab of product Settings.  
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Using Last Chance - recovery by file signatures 

This recovery method is helpful when primary recovery methods (QuickScan and SuperScan) haven’t 

detected deleted or damaged partitions you are looking for. Advanced Last Chance recovery method allows 
to detect and to recover files by their specific signatures on severely damaged volumes. Supported 117 

standard file signatures, including Music, Photos, Camera Raw Images, eBooks, Office Documents and more. 
Last Chance recovery is the only option when partition recovery was unsuccessful due to serious damage to 

the partitions data. Built-in file Organizer allows to rename and to organize files (detected by signatures) in a 

proper directories structure. 
 

This recovery method tries to detect all un-fragmented files based on their standard signatures. In most 
cases we will be able to detect and properly recover the contents of lost files. However we won’t be able to 

detect the file system attributes (eg. original filename, creation date, modification date etc). Detected and 

recovered files will be grouped by file extension only, and will have abstract file names. The File Organizing 
feature will help you to group your files into folders based on extended file attributes (available for some file 

types). For example, songs may be grouped by artist and or album, and photo images may be grouped by 
camera and the date the photo was taken.  

To use Last Chance recovery method: 

 

1. Launch an Active@ Partition Recovery and click Last Chance toolbar button, or click Last Chance 
from Tools menu  

 
2. Select the disks you wish to analyze, or de-select disks you are not interested in, and click Next  

 

3. Confirm file signatures to be analyzed and de-select file types you are not interested in recovering 
(this will speed up the process significantly) 

 

 
 

4. Click Start button and wait until the scan process completes  

 

5. Review found by signatures files, Preview file content to make sure files are recoverable and it's what 
you need  

 



13  Active@ Partition Recovery Guide 

6. If needed, re-organize found files in folders by specific attributes using File Organizer 

 

7. Select file groups or particular files to be recovered and click Recover toolbar button to recover 
them all at once 

To organize and recover files detected by signatures: 

1. Select SuperScan node in the tree view on the left and Signature Files tab in the list view on the 
right 

 

2. Expand general groups (Music, Documents) and specific sub-types (MP3, XLS,..) to inspect what is 
detected: 

 
3. If file detected by signatures has some extended attributes, like AUTHOR, CREATED, TITLE, etc., 

these attributes will be displayed on the right. By default the only 5 first detected file attributes being 

displayed. To display more attributes, use Show Attributes drop down list 

 
4. By default files are not sorted and displayed in the order of detection. To group files by attributes, 

click the column you want to sort on. If Subsequent Column Sorting option is turned ON, files are 
grouped & sorted on all columns followed the column you clicked. This could be convenient, for 

example, if you want to group music by Artist and then by Album  
 

5. If you want to hide some attributes or change display order, click Organizer button on the toolbar 

to open Signature Files Organizer. Dialog appears and you can change the attribute for the 
particular file type (MP3, XLS, …) to be displayed in the particular column on the screen. For 

example, default column order for music is Artist, Album, Title, Genre, Year,... To group MP3 first 
by Year, then by Artist, then by Album, change column order this way: 
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… and you will see: 

 

 
 

6. To recover files detected by Signatures, select the particular file or group of files, or even all 
signature files and click Recover button. On Recovery Options dialog use Organize by file 

meta-data option to group files in folders based on attributes (meta-data): 

 

 
 

7. Use Attribute-based folder depth parameter to organize recovered files in a specified number of 
sub-folders. For example, for the MP3 files default columns are Artist, Album, Title and default 

folder depth is 2. When you recover MP3s using default parameters, your music files will be 
organized first by Artist, then by Album, so all album songs will be in one folder. If you reorganize 

columns display like in example above (Year, Artist, Album,…) and specify folder depth 3, after 

recovery you’ll have music grouped in folders first by Year, then by Artist, then by Album. 
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Restoring a Deleted or Corrupted Partition 
detected by QuickScan or SuperScan 

There are two basic approaches for restoring all volume data:  

1. Physical recovery of the boot sector and partition table (in-place recovery)  

2. Copy all data to a new safe location (to another attached or external physical disk)  

First option (in-place recovery) works best when the partition/volume was just deleted, or the data and the 

file system on deleted/re-created/re-formatted partition have not been severely damaged (overwritten). In 
this case the recovery process is very fast, and you'll be able to access your files using Windows Explorer (or 

any other program) immediately after recovery. However, if some data overwriting occurred, or damage to 
the file system took place, Windows might not recognize the recovered volume (a drive with an assigned 

letter does not appear), or you may get messages like "Drive is not accessible". In this case you should try 
the second option: copy all existing data from the corrupted volume to a new physical disk.  

There are other scenarios when you do not want to recover your data in-place. You just want to restore all 
live (non-deleted) volume data (files and folders) to another media in a single operation. Possible scenarios 

when this is applicable:  

 USB Flash or Camera Memory Card is damaged or formatted  

 Hard Disk has some physical damage (unreadable or bad sectors)  

 Volume boot sector is damaged by virus or power surge and volume becomes unreadable  

 Partition or volume has been formatted accidentally  

 RAID Disk Array crashed and needs to be re-built  

Copying All Volume Data to another Location 

This approach is the safest way to get all your data backed up to a new safe place (storage), however this is 
also the slowest way. You keep your original damaged disk (all data on it remain untouched), and just copy 

all your valuable information to a dedicated attached HDD/SDD, external USB Disk or USB Flash Card. The 
copy process itself could take a long time, especially in cases where you have terabytes of data (videos or 

photo archives).  

To Copy All Volume Data to a New Disk: 

1. In Active@ Partition Recovery, use QuickScan or SuperScan to detect a deleted or damaged 
partition, verify its content, and select the partition node  

2. To open the Recovery Options dialog box, use one of the following methods: 

  
o Click Recover on the toolbar  

o Right-click the volume, and then choose Recover from the context menu  
o Execute Recover command from Tools menu  

o Press Ctrl+R key combination  

3. Make sure Copy All Data to a New Disk tab is active: 
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4. Select a recovery method:  

 Recover Files & Folders only – copies all safe files and folders from the partition being 

recovered to a new target disk. Original data structure (location of files and directories in 

folder’s tree) and file’s attributes (creation date, read-only flag, etc..) have been duplicated 

as well. Advantage of this method is that copied files are guaranteed to be readable 
(accessible) on a new target. Disadvantage is that system areas, meta-data and deleted data 

are not copied, so future data recovery of damaged file system is not possible on a new 
target. 

 Copy All Volume Data (sector by sector copy) – copies all occupied sectors on the volume 

as it is specified in file system’s allocation bitmap. This means than all system areas (like 

MFT records, or FAT tables) have been duplicated as well, and along with safe files and 
folders you can recover files being marked as deleted as well, so future data recovery is 

possible even from the new disk (target). This can be considered as a significant advantage. 
Disadvantage is that if some system areas (for example MFT, or boot sector) on the found 

partition are damaged, target disk will have exactly the same damaged data, and when 
accessing the new volume, or files on it, you can get error messages, like “access denied”. 

5. Select a designated disk (having enough storage space) to copy all of your data to (target). A list box 
displays all available disks in the system, excluding physical disks where the currently running 

operating system is installed. You can plug-in more disks (or remove some of them them) and the 
software should detect and display them here immediately. Make sure you select a proper target 

disk, as before the data copying occurs it will be formatted (all existing data, if any, will be lost). 

 
6. Click Recover and wait while all volume data is copied to the new destination  

After completion Windows Explorer should be launched and you can access and inspect your data at the new 

location.  

 Important 

Copy All Data to a New Disk command re-formats the target disk, destroying all data on it, before all data 
being copied to. Be careful and select a proper target disk, which doesn’t contain anything important! 
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Restoring a deleted/damaged volume in-place 

This approach is the fastest way to return your volume "back to life" in the place where it resided originally. 

However this could be a dangerous and non-guaranteed method. Recovery of partition information, 
volume boot sector and partition table usually takes only a couple seconds. However, you need to be 

absolutely sure that you recover a proper volume, and recovery is successful only when file system itself has 

not been damaged previously.  

This way works best when you just deleted a volume, realized the problem, and immediately started the 

recovery process. In this case not many data overwrite operations occurred within the Windows 
environment, so most of your data structures would not have been damaged.  

In case if you formatted the disk and installed a new OS, or copied some files to a newly formatted partition, 

you may still try this approach. However, chances that some critical file system data structures have not 
been damaged are low, and most likely Windows would not be able to access a logical disk after recovery 

and you will see something like: "Volume is not accessible or damaged" and "Do you want to format the 
volume?", and you'll need to delete this invalid partition and try another approach.  

To evaluate your chances for successful physical recovery (in-place recovery), take a look at the icon besides 

the found volume. You can distinguish deleted partitions from existing ones by the icons: 

 Grey icon shows an existing partition or drive visible in Windows Explorer 

 Green icon shows live drive in SuperScan results (having a letter assigned)  

 Grey icon with green mark shows a deleted partition with an excellent integrity status. This means 

the chances for successful in-place recovery are good 

 Grey icon with brown mark shows a deleted partition with an acceptable integrity status. This means 

that there is some chance for successful in-place recovery 

  Grey icon with red mark shows a deleted partition with Poor integrity status. However this partition 
might have been formatted before deletion or has some other damage, so there are minimal chances of 

successful volume recovery in-place 

To restore a deleted partition: 

1. In Active@ Partition Recovery, use QuickScan or SuperScan to detect deleted partition, verify its 
content and select the deleted partition node.   

2. To open the Recovery Options dialog box, use one of the following methods:  

o Click Recover on the toolbar  

o Right-click the file, and then choose Recover from the context menu  
o Execute Recover command from Tools menu  

o Press Ctrl+R key combination  

3. Make sure Recover Volume in-Place tab is active: 
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4. To assign a partition to be recovered non-default disk letter, you may choose one of available letters 

from the drop-down box  
5. To mark a partition to be recovered as an Active , you may check the related check box. Be careful! 

If you mark as an Active a partition that does not have system files on it for the booting process - 

your computer might not boot properly. So mark it as an Active only when you sure 100% percent 
that partition being recovered had an Active status before deletion  

6. In some cases partition being recovered seems to be not a Primary type, but the Logical Disk in the 
Extended  partition. In this case Create Extended Partition First options will be available, if no 

Extended partition exists on the disk. Keep it turned on if you want to create Extended  partition 
container first, then to place your recovered partition inside. If option use ALL Unallocated area is 

turned off - Extended partition (container) will have the same size as partition being recovered, 

otherwise Extended partition (container) would occupy all unallocated space on the disk  
7. You have an option to execute either Automatic or Manual recovery to check and fix  the Volume 

Boot Sector. If you are not familiar with disk low-level structures, use Automatic mode. If you know 
a lot about sectors, clusters, FAT, MFT, etc.. you can choose Manual mode to check the parameters 

manually and to select the most appropriate action  

8. Click Recover  

After the recovery process is complete, a confirmation message pops up. Make sure that the results are 
correct by verifying the contents of the recovered partition in the Windows Explorer. Recovered partition 

should appear there after you refresh its content. 

  

Manual mode for Volume Boot Sector Recovery 
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If you've chosen Manual mode for the Boot Sector Check & Fix, dialog like above appears.  

You can: 

 Verify the parameters of the Primary and Copy of Boot Sector located on the disk. Parameters that 

look like invalid are marked with a red mark. Boot Sector Template column is formed 
programmatically and contains the most appropriate parameters for the partition found  

 Save to the file raw Primary Boot Sector or Copy of Boot Sector to be able to analyze these raw 

values in Hex Editor or third party software, or restore them back if recovery is unsuccessful  
 Load from the file raw Primary Boot Sector or Copy of Boot Sector to restore them back after 

unsuccessful recovery  

 See the Overall Status of Partition Boot Sectors (their validity and match)  

 Choose an Action to execute for the Boot Sectors while partition recovery:  

1. Duplicate Primary Boot Sector into a Copy of Boot Sector - if you are sure that Primary Boot 
Sector is valid, but Copy is not  

2. Duplicate Copy of Boot Sector into a Primary Boot Sector - if you are sure that Copy of Boot 
Sector is valid, but Primary is not  

3. Copy Boot Sector Template into both Boot Sectors - if both Primary and Copy of Boot Sector 
look invalid  

4. Do NOT fix Boot Sectors - if both Boot Sectors look valid and match each other and the Boot 
Sector Template values.  

  

In the example above, even you are not a specialist - you can notice that Copy of Boot Sector contains 

some garbage (i.e. damaged), the red marks appear next to the fields, so the most appropriate action is to 

Duplicate Primary Boot Sector into a Copy of Boot Sector.  

 Important 

Recover Deleted Partition command for the hardware device has been automatically logged to the 

partitioning backup file, and you can always rollback you changes later on.  
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 Note 

Recover Deleted Partition function is available in commercial (purchased) version only. 
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Rollback, Backup and Restore Disk Partitioning 
Info 

Disk Partitioning Information is an MBR, Partition Table and Volume Boot Sectors for each existing partition 
on the disk.  

You might ask, "Why should I backup Partitioning Info?"  

Here is the answer: If you something goes wrong while attempting to recover the partition (for example you 
recovered wrong partition), you will be able to restore original partitioning structure for the drive being 

repaired. 

  

Automatic Partitioning Backups 

When you are trying to resolve your partitioning problem, you usually execute such commands of Active@ 
Partition Recovery as Fix MBR, Fix Boot Sector, Delete Invalid Partition and Recover partition. Every 

command execution has been automatically logged the partitioning backup file. If something goes wrong 
(you recovered not a proper partition, you accidentally removed a valid partition...) you always have a 

chance to rollback your last changes to the system.  

  
Backups are stored for each physical device at the location Partitioning auto-backups default path in 

Settings.  

To rollback partitioning changes: 

1. Start Active@ Partition Recovery and select a physical device that you want to rollback changes 
for  

2. From Tools menu click Rollback Partition Changes... command  
3. Select a backup file, or confirm the backup file default location  

4. Select a restore point to rollback to. If you executed several commands, these commands listed from 

top to bottom, and you can select a particular place to revert to  
5. Click Rollback  

6. Rollback process starts, you can check the results in log  
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  Important 

To be able to rollback partitioning to the any particular restore point, we recommend you to use the only 
standard functions of Active@ Partition Recovery, and avoid using other tools, like Windows Disk Manager (to 

remove partitions, initialize disk, etc..)  

  

To backup Disk Partitioning Info: 

1. Start Active@ Partition Recovery and select a physical device (HDD, USB, MemoryCard...) that 
you want to create a backup for  

2. From Tools menu click Backup Partitioning Info... command  
3. Select a file name and location where to store backup  

4. Click Save  

 

To restore Disk Partitioning Info from the backup: 

1. Start Active@ Partition Recovery and select a physical device that you want to restore backup for  
2. From Tools menu click Restore Partitioning Info... command  

3. Select a backup file  
4. Click Open  

5. Restoration process starts, you can check the results in log  

  

 Important 

Existing disk partitioning structure will be overwritten on the disk where you restore Disk Partitioning Info 
backup file to.  
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Fix Damaged MBR and Delete Invalid Partition 

Fixing MBR  

   

If partition table looks OK for the disk you are recovering (you see all volumes in the Explorer Tree), but your 

computer still does not boot from this disk, it is possible that Master Boot Record (MBR) is damaged by virus 
or overwritten. You can try to use Fix MBR command to replace existing MBR with the one from the set of 

templates (the typical one).  

To fix damaged Master Boot Record (MBR): 

1. Select the disk in you want to fix MBR for (place cursor on it)  
2. In the main window, from the Tools menu, choose Fix MBR (Create Typical MBR)   

3. In confirmation dialog make sure that a proper disk is selected for MBR fixing  
4. Click Yes to confirm the command and wait while list of disks is being refreshed  

Deleting Invalid Partition  

 
If you know for sure that partition on the disk is NOT valid (damaged, or created by mistake instead of 

deleted one, or recovered not properly) you can delete the existing partition first and then try to search for 
partitions being deleted previously. 

 
This is also the only option when you found deleted partition using QuickScan or SuperScan, and you 

know for sure that it is valid, but you are unable to recover it due to overlapping with others existing 

partitions. You are to detect the invalid partition first, delete it and then to recover the only partition you are 
interested in. 

To Delete Invalid Partition: 

1. Verify that existing partition you want to delete is actually invalid partition (Windows Explorer is not 

displaying it properly, or unable to access it and suggests to format it, or displays a garbage instead 
of your files)  

2. Select the partition to be deleted (place cursor on it)  
3. In the main window, from the Tools menu, choose Delete Invalid Partition   

4. In confirmation dialog make sure that a proper partition is selected for deletion  

5. Click Yes to confirm the command and wait while list of disks is being refreshed  

 Note 

You can delete the only existing partition (Primary or Extended) and you cannot delete the System 

partition (Active one or having Windows installed) . If you need to delete the Extended partition, make 
sure that it is empty (no logical drives left in it). If logical drives exist in Extended partition, you are to 

delete them first, then to delete Extended partition itself. 

  

 Important 

Fix MBR and Delete Invalid Partition commands for the hardware device has been automatically logged 

to the partitioning backup file, and you can always rollback you changes later on.  
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 Note 

Fix MBR  function is available in commercial (purchased) version only. 
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Fix Damaged Partition Boot Sector 

Fixing Partition Boot Sector  

   

If partition looks OK for the disk you are recovering (you see all volumes in the Explorer Tree), but Windows 

still does not recognize a volume, or says "Volume is inaccessible" , it is possible that Partition Boot Sector 
(or Copy of Boot Sector) is damaged by virus or overwritten. You can try to use Fix Boot Sector command 

to replace Primary Boot Sector with its Copy (or backward), or both of them from the set of templates 
(typical boot sector). The idea is the same as for the Manual Partition Recovery Mode.  

To fix damaged Partition Boot Sector: 

1. Select the volume (logical disk) you want to fix Boot Sector for (place cursor on it)  
2. In the main window, from the Tools menu, choose Fix Boot Sector... or execute the same 

command from the context menu  

3. In the dialog compare boot sector values, change them if needed, and select an action to execute 

4. Click Recover to confirm the command and wait while list of disks is being refreshed  
  

 

 

 Important 

Fix Boot Sector command for the hardware device has been automatically logged to the partitioning 

backup file, and you can always rollback you changes later on.  

  

 Note 

Fix Boot Sector function is available in commercial (purchased) version only. 
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Apply Boot Sector Template 

Applying Boot Sector Template to any disk’s sector 

In some rare cases partition cannot be automatically recovered successfully due to the damage of boot 

sector structures. Another scenario includes deleted/damaged volume cannot even be found due to critical 

damage of volume structures. 

If you know exact location of a Volume Boot Sector and its parameters, you can try to recover Boot Sector 

manually by applying a proper Boot Sector Template (all major file systems supported) to a particular disk 
sector.  

To apply a Boot Sector Template: 

 Start Active@ Partition Recovery and select any existing or found volume/partition on the 
physical device where you want to apply a Boot Sector Template and click Boot Sector 

Template… from Tools menu or from the context menu 
 Boot Sector Template dialog appears: 

 

 In case if you want to fix not the volume’s first sector (zero numbered) and you know exact location, 

type the sector number to the Selected Sector filed, then click Set Sector button. Alternatively 

you can use plus and minus buttons to navigate. Sectors are numbered starting from zero number 
and navigation occurs only within selected volume/partition 

 Apply a particular File System Template by clicking a related item in the list at the left side. All 

major file systems are supported 

 Chosen File System Template will be applied to the selected sector and file system’s boot sector 

structure will be pre-populated with valued being read from the selected sector 
 Basic validity check is performed and if applied values are valid, these numbers will be displayed in 

green color. If values presumably invalid – you will see red colored values 

 You can change any parameter manually by typing proper values to selected parameters, however 

you need a deep knowledge of disk structures 
 If you are satisfied with an applied template and its parameters, click Save button to store changes 

back to the selected sector on disk. 

 Important 

This feature designed for use by Professionals only. You need a deep knowledge of Boot Sector and File 
System structures to be able to apply proper Boot Sector parameters. 



27  Active@ Partition Recovery Guide 

Create Virtual Device with custom geometry 

Active@ Partition Recovery provides an easy way to create virtual disks based on known geometry that 
makes deleted data accessible. 

 

To create a Virtual Device: 

1. Select a Physical Disk (or opened Disk Image) which will be the base for the virtual device, then from 
the Tools menu, choose Create Virtual Device... This will open Create Virtual Device dialog: 

 

2. To indicate the offset and the size of virtual device, measured in sectors (each sector usually 512 or 
4096 bytes), type the values in the First Sector and Total Sectors fields. 

3. To indicate the size of the sector on virtual device, select a desired value from Bytes per Sector 
combobox. This value can be different from physical sector size on the device. Values mostly used 

are 512 and 4096 bytes. 

4. To indicate the start offset in the sector on base device, fill in Offset in Sector field. Usually disk's 
data objects (partitions, boot sectors...) start with zero offset, however in rare cases some specific 

disk controllers (or even malware, scrumbling the data) could move data start point to non-zero 
offset within a sector. 

5. Click Create to create a Virtual Device. 

6. In the Local System Devices list, a new Virtual Device Node appears. You may treat this new node 

and its contents the same way that you treat other devices in the list. 

You may treat created virtual disks the same way as you treat other disks\devices. You can do QuickScan 
or SuperScan for virtual objects, search for file signatures and perform data recovery for the found files and 

folders. 

 

Create a Disk Image 

A Disk Image is a mirror copy of your entire logical drive or physical device stored as set of files. It may be 

a good idea to create a Disk Image for a drive, if you have enough space on another drive.  

You might ask, "Why should I create a Disk Image on a drive that holds my data?"  
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Here is the answer: If you do something wrong while attempting to recover the partition, you will be able to 

recover all files and folders from the Disk Image that you have wisely created using Active@ Parition 

Recovery or other tools like Active@ File Recovery. 

Disk Image (Active@ Image format) consists of configuration file (with an extension .DIM) and set of file 

chunks having extensions .000, .001, .002 ... By default Active@ Partition Recovery tries to create one file 
(chunk) for the whole volume/device, however, in case if target location is FAT, it may not be possible due to 

file system limitations. In this particular case disk image split to several chunks and each file has a size of 

2Gb. Chunks content can be RAW or RAW-Compressed, depending on settings. 

  

To create a Disk Image: 

1. Start Active@ Partition Recovery and select a drive or physical device that you want to create an 

image for.   
2. To open the Create Disk Image dialog box, do one of the following:  

o Select the Disk or Volume in Local System Devices list and choose Create Image from the 
File menu or press Ctrl+I key combination  

o Right-click the selected item, and choose Create Image on the context menu  

3. In the Save In drop-down list, select another physical device or to another logical drive   
4. Browse to the folder where you want to save the Disk Image  

5. To give the Disk Image file a different name, type one in the File Name field  
6. Click Save 

Watch the progress and wait while drive's contents are copied to the new location.  You may cancel the 
process of image creation anytime by clicking  Stop. 

 Important 

You must always create a Disk Image on a drive other than the source drive. Do not try to save a Disk 
Image of a drive onto itself.  

http://www.file-recovery.com/
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Open and Work with a Disk Image 

A Disk Image is a mirror copy of your entire logical drive or physical device stored as file or set of files. If you 
have enough space on another drive, it may be a good idea to create a Disk Image for a drive containing 

deleted files that you want to recover.  

Active@ Partition Recovery can open: 

 RAW and RAW-Compressed disk images (Active@ Image format: *.DIM)  

 RAW disk images created by third party software (WinHex, etc...)  

 Disk Images (RAW format) composed from several chunks  

 VMWARE (*.vmdk) and VirtualPC (*.vhd) Disk Images  

To open a Disk Image: 

1. Start Active@ Partition Recovery.  
2. To invoke the Open Image dialog, do one of the following:  

o Press Ctrl+O key combination  
o In the File menu, choose Open Image...  

3. Use drop-down listbox at bottom to specify disk image type: Active@ Image, Any RAW image, 

VMWare or VirtualPC disk image  
4. Locate and select disk image file you want to open. Click Open  

5. Confirm Disk Image Type, Bytes per Sector and chunks, specified in configuration file:  

 
6. If there are no configuration file, you can add chunks and change their order manually, using buttons 

at the right side  
7. Click OK to complete configuration and read disk image structures.  

The opened disk image appears in the Local System Devices list. 

You may treat the opened Disk Image node and its content the same way that you treat other device nodes 

in the list. You may follow the same steps to perform SuperScan to detect deleted and damaged volumes, 
to Scan the volume, and then to Recover all files and folders to another location.  

 Note 

If you've created raw disk image using other third-party utilities (like copying sectors from WinHex) you are 

still able to open it! Just choose Any Raw Image disk image type in the Open File standard dialog and you 
will see all files on the disk. Select the required one. 

mk:@MSITStore:D:/PartRecHelp/PartRecovery.chm::/glossary.htm#logical_drive
mk:@MSITStore:D:/PartRecHelp/PartRecovery.chm::/glossary.htm#physical_device
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Inspect file headers and disk data (raw sectors) 
with integrated Disk Editor (Hex Viewer) 

Advanced users and IT professionals may require inspecting raw disk structures before actual recovery 
occurs - to evaluate damage to the data and recovery chances. For these purposes Disk Editor (Hex Viewer) 

supplied as a separate application and is accessible from recovery panel. Launch it from the context menu for 

the object to be inspected (hard disk, volume, file data):  
  

 
  

For NTFS volumes MFT records inspection is available, Disk Editor is launched and MFT record template is 

applied for binary data automatically:  

  

 

Active@ Disk Editor basics 

Active@ Disk Editor uses a simple, low-level disk viewer which displays information in binary and text modes 

at the same time. You can use this view to analyze the contents of data storage structure elements such as:  

 Hard disk drives  
 SSD & USB Disks  

 Partitions & Volumes  

 Files  
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Download the installation package and get full manual at: www.disk-editor.org  

The Main Features 

 Enhanced template view  

 Detailed MFT record information  

 Side-by-side Compare and Edit  

 Fields coloring with data in tooltips  

 Extensive exFAT support  

 Fast navigation points  

 Filling selection with a pattern  

 Unicode support  

 Quick Disk Info  

 Bookmarks  

 Data Inspector 

 

http://www.disk-editor.org/
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Recovery Tips 

DO NOT WRITE ANYTHING ONTO THE DRIVE CONTAINING YOUR IMPORTANT DATA THAT YOU 
HAVE JUST DELETED ACCIDENTALLY! 

In the event of an accidental partition deletion we strongly recommend that you perform the recovery 
operation as soon as possible. If any new partition is created instead on the same space and some 

information is written there, there is a chance that the writing process may allocate some data in this 

'unoccupied space' thus damaging you data located on the partition deleted previously.  

BACKUP MBR AND PARTITION BOOT SECTORS BEFORE RECOVERY STARTS 

It will allow you to revert HDD back to the state it was before you started the recovery process in case if 
anything goes wrong, let’s say you accidentally recover not a valid partition. 

CREATE DISK IMAGE IF YOU HAVE EXTRA HARD DRIVE, OR OTHER LOGICAL DRIVES ARE BIG 

ENOUGH! 
Disk Image is a mirror of your logical drive that is stored in one file. This can be useful when you want to 

backup the contents of the whole drive, and restore it or work with it later. Before you start recovering 
partitions, it may be a good idea to create a Disk Image for this drive, if you have enough space at another 

drive. Why? Because if you do something wrong while recovering, you still will be able to recover files and 
folders from the Disk Image that you have wisely created. 
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Troubleshooting 

The following scenarios are provided from help service offered to actual customers. 

What problem are you having? 

I got Partition overlaps with other partition(s) error message while recovering. What does it 
mean and what can I do? 

Reason: 

It means that the disk's space for the partition you are trying to recover is occupied by another existing 

partition(s). It also means that you are either trying to recover an improper partition, or, if you are 100% 
sure that it is your lost partition - the existing partition located underneath the Hard Drive device is invalid 

(for example, you deleted original partition and re-created a new one instead). 
 

Actions: 

1. Verify that the partition you are trying to recover is an original one and actually contains your data. If 
so, proceed to the step 2.  

2. Verify that the existing partition(s) that overlaps with the one you are trying to recover is invalid. If 

so, you need to delete the existing invalid partition(s) using either the Computer Management 

console, or execute Delete Invalid Partition command from Tools menu.  
3. Find and try to recover your original partition once again.  

 

 Note: 

Selecting, File -> Save Scan Results can save time and avoid having to re-scan the hard drive.  

I got No space in the partition table error message while recovering. What does it mean and what 
can I do? 

Reason: 

It means that partition table is full and there is no space there to insert a recovered one. Standard partition 
table can contain only 4 partitions including one extended. 

 
Actions: 

1. Verify that partition you are trying to recover is an original one and actually contains your data. If so, 
proceed to the step 2.  

2. Verify existing partition(s). Find out invalid one or not needed ones and delete them using either 
Computer Management panel, or execute Delete Invalid Partition command form Tools.   

3. Find and try to recover your original partition once again. 

I got Unable to recover partition because detected file system is invalid! error message while 
recovering. What does it mean? 

It means that file system on the partition being recovered is not supported (i.e. Linux Ext2fs, etc...) or file 
system itself is invalid. Partition Recovery is unable to recover such partitions. 

mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-troubleshooting.htm
mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-troubleshooting.htm
mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-troubleshooting.htm
mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-troubleshooting.htm
mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-troubleshooting.htm
mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-troubleshooting.htm
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I got Partition is recovered however not possible to verify and refresh volumes warning. What 
does it mean? 

Reason: 
It means that partition has been is written back to the partition table, but we are unable to verify the results. 

Windows does not let the software to refresh volumes.  

 
It could also mean that drive letter cannot be assigned for some reason.  

 
Action: 

Try to reboot the machine and verify the results.  

I got Unable to recover the extended partition because another one already exists error. 

What does it mean? 

Reason: 

It means that you are trying to restore Extended partition and another partition of type Extended already 
exists on the disk. Only one extended partition is allowed to reside on the disk.  

 

Actions: 

1. Verify that partition you are trying to recover is an original one and actually contains your data. If so, 
proceed to the step 2.  

2. Verify existing Extended partition. If it is invalid or contains invalid drives, you can delete it using 

either Computer Management panel, or execute Delete Invalid Partition command form Tools 
menu.   

3. Find and try to recover your original partition once again. 

I recovered the deleted partition, however Windows is unable to access it. Message Drive X: is 
inaccessible. Do you want to format it? appears. What does it mean and what should I do? 

Reason: 
It means that underlying file system is damaged on the partition being restored. In spite the fact that 

partition recovery software corrected MBR, Partition Table and Boot Sectors - something else within file 
system is damaged (or overwritten) on the recovered drive, for example - MFT records on NTFS, Root or FAT 

areas on FAT. As long as disk integrity test is not passed, Windows displays such a message.  

It could happen in case if you've recovered not a proper partition or in case if file system is actually 

damaged. 

 
Actions: 

1. Verify that partition you are trying to recover is an original one and actually contains your data. If 
several partitions has been detected - make sure that you have selected the proper one. If you 

realized that you've recovered not a proper one - delete it in Computer Management panel and 
try the recovery process once again. To delete not a properly recovered partition you can also 

execute Delete Invalid Partition command form Tools menu. You can also use SuperScan 
method to scan the whole disk's surface and detect all possible partition information. Then to filter 

out the garbage and look for the proper partition in the list. If something else that looks like a valid 

data is found - delete not a properly recovered partition and try to recover the valid one.  

mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-troubleshooting.htm
mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-troubleshooting.htm
mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-troubleshooting.htm
mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-troubleshooting.htm
mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-troubleshooting.htm
mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-troubleshooting.htm
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2. In case if you 100% sure that you've recovered your partition and Windows is still unable to access 

it, the only option to save your data is to copy files and folders from the damaged partition to the 
another safe location. You can upgrade to and use Active@ File Recovery software to do it as well 

as any third party software.  Active@ Partition Recovery Enterprise also contains Active@ File 
Recovery utility in its package. Before proceeding to the step 3, we strongly recommend you either 

to recover particular files and folders using any file recovery software, or Create Disk Image for 

the disk being recovered (to be able to recover files and folders later on from the raw disk image).  

3. As a last chance is to execute Check Disk Windows command hoping that the Windows itself could 
repair damaged file system structures. Open Windows Explorer, go to Disk Properties, switch to 

Tools tab, and execute Check Now... command. We strongly recommend you to recover particular 

files and folders first, or create backup image for the disk being checked (to be able to recover files 
and folders from the image later on) before Check Disk starts. It often happens that Check Disk 

fixes file system structures, however part or all the user's data (files and folders) are lost. Recovered 
disk might look like just formatted. 

 



37  Active@ Partition Recovery Guide 

Frequently Asked Questions (FAQ) 

  

Does Active@ Partition Recovery work under Windows 2000 / XP / Vista? 

Yes, it does. 

Does Active@ Partition Recovery work under Windows 3.x 

No. Support of 16-bit operation systems like Windows 3.1 is not implemented. 

What is a Disk Image? Why is it needed?  

Disk Image is a mirror of your logical drive that is stored in one file. This can be useful when you want to 

backup the contents of the whole drive, and restore it or work with it later. Before you start recovering the 
deleted files, it may be a good idea to create a Disk Image for this drive, if you have enough space at 

another drive. Why? Because if you do something wrong while recovering the files (for example, recovering 
them onto the same drive could destroy their contents), you still will be able to recover these deleted files 

and folders from the Disk Image that you have wisely created.  

 

mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-faq.htm
mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-faq.htm
mk:@MSITStore:C:/temp/PartRecoveryHelp/PartRecovery.chm::/file-recovery-faq.htm
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Glossary of Terms 

boot record 

 See boot sector.  

boot sector 

 The boot sector continues the process of loading the operating system into computer memory. It can 

be either the MBR (see MBR, below) or the partition boot sector (see partition boot sector, below).  

cluster 

 A group of disk sectors that contain file data. It is the smallest allocation unit for storing a file. For 
example, if the file size is 100 bytes and the cluster size is 4096 bytes, the file system reserves one 

cluster, or 4096 bytes for file data.  

device node 

 In the Local System Devices list, a physical device containing logical drives. The first physical device 
is named 80h.  

FAT 

 File Allocation Table. An area that contains the records of every other file data and directory in a 

FAT-formatted hard disk drive. The operating system needs this information to access the files and 
define the data cluster's chain. There are FAT32, FAT16 and FAT versions.  

file 

 A collection of data with a file name and file attributes, like size.. Almost all information stored in a 

computer must be in a file.  

folder 

 An object that can contain a group of files. Folders are used to organize information. In DOS and 
UNIX, folders are called directories or root areas.  

HDD 

 Hard disk drive.  

log file 

 A file that lists all events that have occurred. For example, Active@ Partition Recovery writes a log 

file entry for every request made to the program and every event that happens as a result. You can 
see the log at the bottom of the main screen.  

logical drive 
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 A partition is a logical drive because it does not affect the physical hard disk other than the defined 
space that it occupies, yet it behaves like a separate disk drive.  

MBR 

 The Master Boot Record (MBR) is a small program that is executed when the computer is first turned 

on. Typically, the MBR can be found on the first sector of a disk. The MBR first reads the disk's 

partition table to determine which partition is used to load the operating system. The MBR then 
transfers control to this partition's "boot sector" to continue the process. Loading the operating 

system is called "booting" the computer.  

MFT 

 Master File Table. A file that contains the records of every other file and directory in an NTFS-
formatted hard disk drive. The operating system needs this information to access the files.  

NTFS 

 NT File System. NTFS was created to provide a more reliable operating system, compared to the FAT 

file system.   

partition 

 A section of memory or hard disk isolated for a specific purpose. Each partition can behave like a 
separate disk drive.  

partition boot sector 

 On NTFS or FAT file systems, the partition boot sector is a small program that is executed when the 

operating system tries to access a particular partition. On personal computers, the Master Boot 
Record uses the partition boot sector on the system partition to determine file system type, cluster 

size, etc. and to load the operating system kernel files. Partition boot sector is the first sector of the 
partition.  

partition status 

 SuperScan gives each partition a rating depending on how likely it is to recover data on the partition. 

A status rating of 1 is very bad. A status rating of 8 is excellent.  

physical device 

 A piece of hardware that is attached to your computer by screws or wires. A hard disk drive is a 
physical device. It is also referred to as a physical drive.  

root area (and root folder) 

 An object that can contain a group of files in a FAT file system. In other words, a directory or folder. 

The root folder is the top-level folder that has no parent and can have children. A logical drive can 

have only one root folder. Its name is usually ‘.’ (dot).  

sector 
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 The smallest unit that can be accessed on a disk. Tracks are concentric circles around the disk and 
the sectors are segments within each circle.  

volume 

 A fixed amount of storage on a hard disk. A physical device may contain a number of volumes. It is 

also possible for a single volume to span a number of physical devices.  

 


